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Legal Notices 
© Agilent Technologies, Inc. 2010, 2012 
No part of this document may be 
photocopied, reproduced, or translated to 
another language without the prior 
agreement and written consent of Agilent 
Technologies, Inc. as governed by United 
States and international copyright laws. 

Warranty 
The material contained in this document 
is provided “as is,” and is subject to 
being changed, without notice, in future 
editions. Further, to the maximum extent 
permitted by applicable law, Agilent 
disclaims all warranties, either express or 
implied, with regard to this manual and 
any information contained herein, 
including but not limited to the implied 
warranties of merchantability and fitness 
for a particular purpose. Agilent shall not 
be liable for errors or for incidental or 
consequential damages in connection 
with the furnishing, use, or performance 
of this document or of any information 
contained herein. Should Agilent and the 
user have a separate written agreement 
with warranty terms covering the material 
in this document that conflict with these 
terms, the warranty terms in the separate 
agreement shall control. 

Manual Editions 
Manual Part Number: 14585-90001 
Third Edition, June 2012 
Available in electronic format only. 

Updates of this manual containing minor 
corrections and updates may have the 
same edition date. Revised editions are 
identified by a new edition date. 

Exclusive Remedies 
THE REMEDIES PROVIDED HEREIN ARE 
THE CUSTOMER'S SOLE AND EXCLUSIVE 
REMEDIES. AGILENT TECHNOLOGIES 
SHALL NOT BE LIABLE FOR ANY DIRECT, 
INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES, WHETHER 
BASED ON CONTRACT, TORT, OR ANY 
OTHER LEGAL THEORY. 

Assistance 
This product comes with the standard 
product warranty. Warranty options, 
extended support contacts, product 
maintenance agreements and customer 
assistance agreements are also available. 
Contact your nearest Agilent 
Technologies Sales and Service office for 
further information on Agilent 
Technologies' full line of Support 
Programs. 

Technologies Licenses 
The hardware and or software described 
in this document are furnished under a 
license and may be used or copied only in 
accordance with the terms of such 
license.  

U.S. Government Restricted 
Rights 
Software and technical data rights 
granted to the federal government include 
only those rights customarily provided to 
end user customers.  Agilent provides this 
customary commercial license in 
Software and technical data pursuant to 
FAR 12.211 (Technical Data) and 12.212 
(Computer Software) and, for the 
Department of Defense, DFARS 252.227-
7015 (Technical Data – Commercial 
Items) and DFARS 227.7202-3 (Rights in 
Commercial Computer Software or 
Computer Software Documentation). 

Trademarks 
Microsoft and Windows are U.S. 
registered trademarks of Microsoft 
Corporation. 
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The Agilent 14585A Control and Analysis software is a Windows-
based PC application that is designed to control up to four Agilent 
N6705 DC Power Analyzers. The Agilent 14585A application has four 
primary functions: scope measurements, data logging, 
CCDF/histogram, and arbitrary waveform generation. Additionally, 
the software has an instrument control pane that emulates the basic 
front panel controls of the Agilent N6705. 

There are two preliminary steps that need to be completed in order 
to use the Agilent 14585A software. 

• The first step is to install the Agilent IO Libraries Suite 15.5 
or higher. This software is included on the Automation-Ready 
CD-ROM that was shipped with your N6705A mainframe. 
Alternately you can download it from the Web at  
www.agilent.com/find/iolib 

• The second step is to connect an Agilent N6705 mainframe to 
one of the supported interfaces as explained in the Agilent 
N6705 User’s Guide. 

 

NOTE You can contact Agilent Technologies at one of the following telephone 
numbers for warranty, service, or technical support information. 
In the United States: (800) 829-4444 
In Europe: 31 20 547 2111 
In Japan: 0120-421-345 
Or use our Web link for information on contacting Agilent in your country or 
specific location: www.agilent.com/find/assist 
Or contact your Agilent Technologies Representative.  

The web contains the most up to date version of the manuals. Go to 
www.agilent.com/find/N6705 to get the latest version of the manuals. 

 

 

http://www.agilent.com/find/iolib
http://www.agilent.com/find/assist
http://www.agilent.com/find/N6705
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System Requirements 

Computer: 
 Pentium 2 GHz, with 2 Gbytes of RAM, 2 Gbytes disc space 

Supported Platforms: 
 Windows XP SP2 with Microsoft .NET framework version  

3.5 SP1 only 

 Vista SP1 

 Windows 7 (32-bit and 64-bit) 

Supported Interfaces: 
 Agilent 82350B GPIB Interface 

 Agilent 82357A USB/GPIB Interface 

 Agilent E5810A LAN/GPIB Gateway 

 National Instruments GPIB card (requires NI-488.2 (Win32) 
version 1.6 or later) 

 LAN 

 USB (not recommended for long-term data logging) 

Supported Libraries (requires one): 
 Agilent IO Libraries Suite 15.5 or later  

o Supplied with the Agilent N6705 on the Product 
Reference CD-ROM or downloadable from 
www.agilent.com/find/iolib 

o This must be installed before you install the Agilent 
14585A application 

 National Instruments VISA Run-time Engine version 2.6 

Supported Instruments: 
 From one to four Agilent N6705A or N6705B DC Power 

Analyzer mainframes 

Agilent 14585A Limitations: 
 The arbitrary Waveform generator  output frequency is 

limited to 10 kHz 

 Data logger measurements are limited to either voltage or 
current on power modules that do not have simultaneous 
measurement capability (refer to 
http://cp.literature.agilent.com/litweb/pdf/N6700-90001.pdf). 

http://www.agilent.com/find/iolib
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Installation 
Before running the Agilent 14585A application, you must have 
installed and connected the DC Power Analyzer to a computer with 
the appropriate interface cable. You must also have the appropriate 
interface card or IO libraries installed and configured. If you are 
using an Agilent interface card, you must have the appropriate VISA 
library drivers installed. 

To Install the Agilent 14585A application: 
• Place the CD-ROM in the CD-ROM drive of your computer 

and run Agilent 14585A.exe. Note that you can download the 
latest version of the software at www.agilent.com/find/14585  
 
When the installer runs, it puts up the following dialog box: 

 

• Follow the directions on the screen to install the software. If 
supplied, a readme.txt file will provide product updates or 
corrections that are not documented in the built-in help. Use 
any text editor to open and read this file. 

To Run the Agilent 14585A application:  
• Click on its Desktop icon:  

You can also click on the Start button and select:  
Programs | Agilent 14585A Control and Analysis Software. 

 

http://www.agilent.com/find/14585
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This chapter shows you how to quickly get started. It describes how 
to connect to an Agilent N6705 DC Power Analyzer. In the example 
given, an output turn-on sequence is programmed and displayed 
using the scope function. The scope measures the actual output 
voltages as the outputs turn on. The scope waveforms are then saved 
and exported. 
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Connect to the Agilent N6705 DC Power Analyzer 
Step 1. Click the Connect button next to the instrument label (A, B, C, or D) 

that will identify the instrument to which you will be connecting. 
Click the right arrow to display labels C and D. 

Step 2 The application automatically searches to find all the instruments on 
the network and VISA resources. If the VISA resource does not 
appear, you may need to manually add the VISA resource using your 
IO library software. If you want to re-run the search, click the Search 
button. 

If your instrument does not appear on the list, click Manual 
Connection.  If using the Sockets IO library, provide the IP address 
or Hostname. If using VISA, provide the VISA resource descriptor. 
Click Test Connection to verify the connection and add the 
instrument to the list. 

Select your instrument and click OK to connect. 

 

Click Simulation if you want to run the application in simulation 
mode with no instruments connected. This only provides limited 
functionality of the application. 
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Step 3 If you have previously connected to an instrument, you can also 
connect to one of the N6705 units listed in the drop-down Connect 
menu shown on the bottom of the main window under Instrument A, 
B, C, or D. 

 

Step 4 Click Configure to access the Configure IO dialog. 

 

NOTE You can configure the connections options by selecting the Tools menu, User 
Preferences,  IO Configuration. 
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Set Up the DC Power Analyzer 
To set up the Agilent N6705A, select the Instrument Control tab on 
the left side of the display. You can directly control the instrument 
using the controls on this display, or use the front panel controls. 
Note that the changes made on either interface (the PC application or 
actual front panel) will be mirrored in the other interface. 

Step 1. In Meter View, set the 
output voltage and 
currents of all four 
outputs of the DC 
Power Analyzer to 10 
volts and 1 ampere. 

 

 

Step 2. Click the Source 
Settings button twice. 
In the Output On/Off 
Delay area, configure 
the output turn-on 
sequence as follows. 
You will only need to 
configure the Turn-on 
delays, not the Turn-
off delays. 
 
Output 1: 10 ms; 
Output 2:  20 ms; 
Output 3: 30 ms; 
Output 4: 40 m 

 

 



Getting Started    2 

14585A Quick Start Guide 13 

Select and Configure the Scope Function 
Step 1. Select the Scope function from the functions listed on top of the 

window. 

Step 2. Select which output traces to display (select the voltage traces for all 
four outputs). 

Step 3. Configure the vertical scale for all outputs (set the vertical scale to 10 
volts/division). 

Step 4. Configure the horizontal scale for all outputs (set the timebase to 20 
milliseconds/division). 

Step 5. Select a voltage level on output 1 as the Scope trigger source. Set the 
level to 1 volt. 

Step 6. Select Single mode. 
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Run the Scope and Turn on the Outputs 
Step 1. Press the Scope button on the bottom of the screen to run the scope. 

The arrow icon indicates the start action. 

Step 2. In the Instrument Control area on the front panel of the instrument, 
press the All Outputs On button to start the output sequence. 

Step 3. The selected waveforms will be displayed on the screen. 

 

The Run buttons can also be used to stop the application. The square 
icon indicates the stop action. 

NOTE You can copy any display image to the clipboard by selecting the Edit menu, 
Copy Chart Image. 
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Save and Export the Display Data 
All waveforms in the measurement display can be saved to an 
internal file or exported to an external .csv file.  

To save the Display Data 

In the File menu, select Save. Specify the directory and filename in 
which you will save the waveform data. All Scope waveform data is 
saved with a .scp file extension. These Internal files can be loaded or 
overlayed onto an existing "active" display for waveform comparison 
purposes. 

To Export the Display Data 

In the File menu, select Export Data. This command lets you select 
the traces to export. 

The data from the selected traces is written to a .csv file. This file 
may be opened using a number of applications such as Microsoft 
Excel. Each trace is assigned its own column in the file, followed by 
all of the data points for the trace. 
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This chapter describes how to use the Agilent 14585A software. It 
describes the four primary functions: scope, data logger, CCDF, and 
Arb. It also discuses how to trigger the functions, how to obtain 
detailed measurement information using the markers, and how to 
export the measurement data. 

Additional information on specific features and capabilities of the 
Agilent 14585A software are included in the built-in help, which can 
be accessed at any time via the Help menu. 
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Controlling the DC Power Analyzer 
Click the Instrument Control tab to open the instrument control 
window. The functions of this window emulate the front panel 
controls of the Agilent N6705 DC Power Analyzer. 

 

Meter - Displays the meter view. Toggles between single output and 
multiple output views. 

Set V/I - Displays the settings of the selected output. Toggles between 
source settings and output delay setting. 

Properties - In meter view, displays the meter properties of the 
selected output. In source settings view, displays the N6705 ratings. 

Menu - Displays the function menu. 

Back - Returns to the previous view 

Select Output 1, 2, 3, 4 - Lets you select an output to control. 
                        On, On, On, On - Turns an output on or off. 

All On - turns all outputs on. 

All Off - turns all outputs off. 
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Using the Scope Function 
Select the Scope button from the top of the window. 

Making a Scope Measurement 
Step 1.  Select the traces (voltage V, current I, or power P) you want to 

capture in the Output boxes on the bottom of the display. You can 
also display Formula traces that are calculated from active voltage or 
current traces. 

Note that there is a limit to the number of measurement traces that 
you can select, depending on the power module.  

Step 2.  Specify the measurement setup: 

Ranges – selects the measurement range. Select the range that is the 
best fit for your expected measurements. 

Points – lets you specify the number of measurement points (this 
determines the sample period) 

Trigger – lets you specify the trigger source (see “Triggering 
Measurements and Arbs”). 

Mode – lets you select the measurement mode: Automatic, Single 
measurement, or Triggered.  

Slope/Level - if you have specified a voltage or current level trigger 
source, you must also specify the signal slope and level. 

Step 3.  Use the Scope Run button on the bottom of the screen to start the 
measurement.  
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Step 4.  Use the Scope Stop button to stop the measurement.  

NOTE If you are running an Arb in conjunction with a scope measurement, you can 
configure the Arb Run button as the scope trigger source. Arm the scope by 
clicking the Scope Run button. Then click the Arb Run button to start the scope 
and the Arb. 

Step 5.  After the measurement is taken, you can use the measurement 
markers to calculate data from specific areas of the measured 
waveform. Click Markers and Measurements to display the 
measurement markers. The Marker Delta measurements (Min, Ave, 
Max, RMS, Peak-to-peak, Charge/Energy) are calculated on the 
portion of the waveform between the marker positions. The 
information under Marker 1 and Marker 2 indicate the location of the 
markers. Click Setup to select or deselect the measurement items. See 
“Marker and Display Measurements” for more information.  

Step 6.  You can use the Grid controls (time/div, autoscale, zoom in, zoom 
out, etc.) to inspect the measurement in greater detail. 

Step 7.  You can export selected traces from the display to a .csv file. See 
“Export the Display Data” for more information. 

Using the Data Logger Function 

NOTE The Data Logger function is not available on Agilent N6705 mainframes with 
Option 055 "Delete Data Logger". 

Select the Data Logger button from the top of the window. 
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Running the Data Logger 
Step 1. Select the traces (voltage V, current I, or power P) you want to 

capture in the Output boxes on the bottom of the display. You can 
also display Formula traces that are calculated from active voltage or 
current traces. 

Note that there is a limit to the number of measurement traces that 
you can select, depending on the power module.  

Step 2. Specify the data logger setup: 

Ranges – selects the measurement range. Select the range that is the 
best fit for your expected measurements. 

Duration – lets you specify the duration of the datalog in hours, 
minutes, and seconds. 

Sample Period – specifies the interval between data samples in 
milliseconds. This is the integrated sample period. 

Log Min/Max - logs the minimum and maximum values of each 
sample to the datalog file in addition to the average value.  

Filename – specifies a filename in which to save the data. Data will 
be logged to this filename the next time the data logger runs. It is 
recommended to save data to a local hard drive. 

Trigger – lets you specify the trigger source (see “Triggering 
Measurements and Arbs”).  

Step 3. Use the Data Log Run button on the bottom of the screen to start the 
measurement.  

Step 4. Use the Data Log Stop button to stop the measurement.  

NOTE If you are running an Arb in conjunction with the data logger, you can configure 
the the Arb Run button as the datalog trigger source. Arm the data logger by 
clicking the Data Log Run button. Then click the Arb Run button to start the 
data logger and the Arb. 

Step 5. After the data logger is finished, you can use the measurement 
markers to calculate data from specific areas of the logged data. Click 
Markers and Measurements to display the measurement markers. The 
Marker Delta measurements (Min, Ave, Max, Peak-to-peak, 
Charge/Energy) are calculated on the portion of the data between the 
marker positions. The information under Marker 1 and Marker 2 
indicate the location of the markers. Click Setup to select or deselect 
the measurement items. See “Marker and Display Measurements” for 
more information.  

Step 6. You can use the Grid controls (time/div, autoscale, zoom in, zoom 
out, etc.) to inspect the data in greater detail. 

Step 7. You can use the Insert Tag button  to insert event tags (the round 
objects) to describe specific conditions or events on the datalog. 

Step 8. You can export selected traces from the datalog to a .csv file. See 
“Export the Display Data” for more information. 
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Using the CCDF Function 

NOTE The CCDF and histogram functions only apply to Agilent Models N6781A and 
N6782A, and only for current measurements. 

Select the CCDF button from the top of the window.  

The CCDF or Complimentary Cumulative Distribution function 
concisely summarizes short and long-term battery drain 
measurements for analysis and comparison. It is a cumulative 
distribution of the amplitude versus the frequency (or percent) of 
occurrence. This is especially useful for analyzing signals that are 
random over time. 

 

Click the Histogram tab to view the Histogram function.  

The histogram function plots the frequency of measurement values in 
successive numeric intervals of equal size. The data collected in the 
histogram forms the basis for the CCDF function.  
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Making a CCDF/Histogram Measurement 
Step 1. Select the traces (voltage V, current I, or power P) you want to 

capture in the Output boxes on the bottom of the display 

Step 2. Specify the measurement setup: 

Ranges – selects the measurement range. Select the range that is the 
best fit for your expected measurements. Select Auto if your 
measurement encompasses multiple ranges. 

Duration – lets you specify the duration of the data log in hours, 
minutes, and seconds.  

Filename - specifies the filename to which the data will be saved. It is 
recommended to save data to a local hard drive. 

Trigger – lets you specify the trigger source (see “Triggering 
Measurements and Arbs”). 

Properties – summarized the properties that have been specified for 
the CCDF measurement. 

Step 3. Use the CCDF Run button on the bottom of the screen to start the 
measurement.  
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Step 4. Use the CCDF Stop button to stop the measurement.  

NOTE If you are running an Arb in conjunction with a CCDF measurement, you can 
configure the the Arb Run button as the CCDF trigger source. Arm the CCDF 
measurement by clicking the CCDF Run button. Then click the  Arb Run button 
to start the CCDF measurement and the Arb. 

Step 5. After the measurement is taken, you can use the measurement 
markers to calculate data from specific areas of the measured 
waveform. Click Markers and Measurements to display the 
measurement markers. The Marker Delta measurements (10%, 1%, 
0.1%) are calculated on the portion of the waveform between the 
marker positions. The information under Marker 1 and Marker 2 
indicate the location of the markers. You can select the CCDF range 
to display data from the combined histogram ranges, only the high 
range, or only the low range.  

Step 6. You can select the Histogram tab to view the histogram data from 
which the CCDF plot was derived. The Marker Delta measurements 
are calculated on the portion of the waveform between the marker 
positions. The information under Marker 1 and Marker 2 indicate the 
location of the markers. You can select the Histogram range to 
display data from the combined histogram ranges, only the high 
range, or only the low range. See “Marker and Display 
Measurements” for more information.  

Step 7. You can export selected traces from the display to a .csv file. See 
“Export the Display Data” for more information. 
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Using the Arbitrary Waveform Function 

NOTE There is a 10 kHz frequency limit for all arbitrary waveforms. This is the highest 
frequency available that still provides good output fidelity for each Arb. 

Select the ARB button from the top of the window.  

Creating an Arb Sequence from the Built-In Waveforms  
Step 1. Select an output function using the V or I button in one of the Output 

boxes on the bottom of the display. 

Step 2. Select the Sequence type, either 64K-point Constant Dwell, 512-point 
Sequence, or Fixed DC Level.  

Step 3. Click the Add button in the Navigation area to start adding sequence 
components. 

The following steps add a sine wave to the sequence. 

Step 4. Click the Built-in tab and select the sine wave. Use the scroll bar to 
display all of the components.  

Step 5. You can modify the parameters of the sine wave in the parameter 
fields in the center. 

Step 6. You can view the results of any modification in the Preview area on 
the right side. 

Step 7. When you are satisfied with the edits, click Done in the Navigation 
area to add the sine wave to the Arb sequence. 
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Repeat steps 4 - 7 and add a triangle to the sequence. 

Step 8. Select the Fixed DC trace on the bottom of the Arb Waveform 
window and specify a value for the fixed parameter of the output. If a 
voltage Arb is programmed, the current level is fixed. If a current Arb 
is programmed, the voltage level is fixed. The diagram on the lower 
left of the display indicates the range of acceptable values for the 
fixed voltage or current parameter.  

Step 9. Use the Navigation controls to edit the sequence. The arrow buttons 
select the component. Move Left moves the component one position 
to the left. Move Right moves the component one position to the right. 
Add adds a new component. Modify lets you modify the selected 
component. Delete deletes the selected component.  

Step 10. Specify the Sequence setup: 

Sequence Repeat – lets you specify the number of times the 
sequence repeats: select Continuous to run the sequence 
continuously, or enter a specific repeat count in the Count field. 

Ranges – lets you specify the source ranges. 

Trigger – lets you specify the trigger source (see “Triggering 
Measurements and Arbs”). 

You can save some or all Arb waveform sequences that were created. 
See “Save and Load the Waveforms” for more information. 

You can also add waveform components from a formula or from an 
imported waveform file. “See Creating a Formula Waveform” and 
“Importing a Waveform File” for more information. 

Save and Load the Waveforms 

Saving the Waveform 
Saved waveform information includes all Arb waveform sequences 
that were created. You can select which waveforms to save. 

Step 1. Select the File menu from the top of the main window. Then select 
Save Waveform to save the selected waveform. 

The Save Waveform command applies to the Arb function only. You 
can select any or all waveforms that were created in the Arb function 
window by checking the appropriate waveform in the "Select Traces" 
column. 

Step 2. Select a directory and filename in which to save the waveform data. 
File format extensions include: 

".wfpk" for Arb waveform sequences  

Loading a Waveform 
Loading waveforms differs from importing waveforms. You can only 
load Arb waveform sequences that have been previously saved using 
the Save Waveform command. Waveforms are loaded directly into the 
target output channel. 
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Importing waveforms, on the other hand, places any number of 
individual internal or external waveform components into the 
Imported folder. From there they can be renamed, edited, and added 
to an Arb sequence. See Import a Waveform File. 

Step 1. Select the File menu from the top of the main window. Select Load 
Waveform to load a previously saved  Arb waveform sequence. 

The Load Waveform command applies to the Arb function only.  

Step 2.  Select the directory and filename to load. 

Step 3. Select the waveforms from the loaded file and assign them to an 
output channel. 

The Arb waveforms can be assigned to an output channel, then run. 
Assign a waveform to an output channel by dragging it from the 
"Waveforms loaded from file" column to the target output channel. 
You can only output a voltage Arb or a current Arb on a given 
channel; not both.   

Creating a Formula Waveform 
The following steps create three waveforms using formulas: 
superimposed noise, masked segment, and absolute value. 

Step 1. Select an output function using the V or I button in one of the Output 
boxes on the bottom of the display. 

Step 2. Select the Sequence type, either 64K-point Constant Dwell, 512-point 
Sequence, or Fixed DC Level. 

Step 3. Click the Add button in the Navigation area to start adding sequence 
components. 

The following steps superimpose noise on a sine wave. 

Step 4. Click the Formula folder, select the sin(x) formula, set the duration to 
1.5 seconds, and press Preview. 

sin(2*PI*x) 

Step 5. Select the + sign, then select  the Random formula and press Preview. 

sin(2*PI*x)+random(0.5) 

The following step moves the part of the waveform between 0.15 s 
and 0.3 s up 1 volt. 

Step 6. In the Formula folder, select the + sign, then select the MaskOn 
formula. Change the range of the MaskOn formula from 0.15 s to 0.3 s 
and press Preview. 

sin(2*PI*x)+random(0.5)+MaskOn(x,0.15,0.3) 

The following step applies the absolute value function to the formula. 
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Step 7. In the Formula field, move the text cursor all the way to the left of 
the formula string and type "abs(". Move the text cursor all the way to 
the right of the formula string and add another ")" as shown below. 
Press Preview. 

abs(sin(2*PI*x)+random(0.5)+MaskOn(x,0.15,0.3)) 

Step 8. In the Navigation area, click Done to add the formula components to 
the selected output channel. 

Step 9. Select the Fixed trace on the bottom of the Arb Waveform window 
and specify a value for the fixed parameter of the output. If a voltage 
Arb is programmed, the current level is fixed. If a current Arb is 
programmed, the voltage level is fixed. The diagram on the lower left 
of the display indicates the range of acceptable values for the fixed 
voltage or current parameter. 

Importing a Waveform File 
The following steps import a waveform file into the Arb sequence. 

Step 1. Select an output function using the V or I button in one of the Output 
boxes on the bottom of the display. 

Step 2. Select the Sequence type, either 64K-point Constant Dwell, 512-point 
Sequence, or Fixed DC Level Constant Dwell Arb, an Arb Sequence, 
or Fixed. 

Step 3. Click the Add button in the Navigation area to start adding sequence 
components. 

Step 4. Click the Import folder and select New. Then navigate to and select a 
file to import. A thumbnail of the imported component will appear in 
the Imported folder.  A Preview of the component will also appear in 
the Component Preview area. 

NOTE Scope traces can be directly placed into the Imported folder. Go to the Scope 
function and select a trace from the display. In the Scope menu, select Save 
Trace to Arb 

Step 5. You can modify the file by selecting Modify. This displays the Modify 
Waveform window. 

Step 6. When you are satisfied with the edits, click Done in the Navigation 
area to add the waveform to the Arb sequence. 

Step 7. Select the Fixed trace on the bottom of the Arb Waveform window 
and specify a value for the fixed parameter of the output. If a voltage 
Arb is programmed, the current level is fixed. If a current Arb is 
programmed, the voltage level is fixed. 
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Triggering Measurements and Arbs 
There are a number of ways to trigger measurements and Arbs. Start 
by selecting a trigger source. Trigger selections are located in the 
drop-down Trigger control of all functions. 

The Run buttons 
The following Run buttons can be selected to trigger a measurement 
or an Arb, depending on which function is presently selected: 

    

The Arb Run button can also be used to trigger a measurement for 
the Scope, Data Logger, and CCDF functions. 

Note that the Agilent N6705 front panel Arb Run button can also be 
selected as the trigger source for the Arb function.  After you click 
the Arb Run button in the Arb window, you must also press the front 
panel Arb Run button to start the Arb. 

Voltage or Current Levels 
The Scope function lets you select a voltage or current level as the 
trigger source. The voltage or current level from any input channel on 
any connected mainframe can be selected as the trigger source. You 
can select only ONE current or voltage level.  

   A-Current 1 for example, selects a current level on channel 1 on 
the "A" mainframe. 

Note that after specifying a voltage or current trigger level as the 
trigger source, you must specify the actual trigger level on the display 
by moving the trigger trace up or down.  Also, the Slope control 
specifies whether a rising edge or a falling edge generates the trigger 
when the signal edge intersects the voltage or current level.  

BNC Input 
Located under "External" in the drop-down Trigger control. 

The BNC input on the rear panel of the Agilent N6705 can be selected 
as the trigger input for the Scope, Data Logger, CCDF, and Arb 
functions. This requires a 5 V low-true trigger signal for a minimum 
of 10 microseconds.  

Digital Port Pin <n> 
Located under "External" in the drop-down Trigger control. 

This selects one of the seven digital port pins as the trigger source. 
This only applies to Scope, Data Logger, and CCDF functions. Signal 
specifications are the same as for the BNC input connector. 
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BNC Input with Trigger Out 
Located under "External" in the drop-down Trigger control. 

This is a special configuration only used when trigger signals must be 
synchronized across multiple mainframes. This applies to the Scope, 
Data Logger, CCDF, and Arb functions. 

Marker and Display Measurements 
Select Markers & Measurements at the bottom of the Scope, Data 
Logger, and CCDF display area. 

Two vertical markers are available for making precise measurements 
on portions of the waveform traces. Use the mouse to select and 
move the markers on the display. The marker positions and distance 
between the markers is displayed in the Marker column. The marker 
measurements are displayed in the columns that appear in between 
the Marker columns.  

Scope and Data Logger measurements  

Measurements Between Markers 

Minimum The minimum value of the waveform segment 
between markers or the portion of the waveform 
that is displayed. 

Average The average (dc) value of the waveform segment 
between markers or the portion of the waveform 
that is displayed. The number of data points 
upon which the measurement is based is 
determined by the sample rate. 

Maximum The maximum value of the waveform segment 
between markers or the portion of the waveform 
that is displayed. 

RMS 
(not available on 
Data Logger) 

The RMS value of the waveform segment 
between markers or the portion of the waveform 
that is displayed. The number of data points 
upon which the measurement is based is 
determined by the sample rate 

Peak to Peak The peak to peak value of the waveform segment 
between markers or the portion of the waveform 
that is displayed. 

Charge(Ah/ 
Energy(Wh) 

For current traces, this integrates the 
Amp/hours of energy  between markers or the 
portion of the waveform that is displayed. 

For power traces, this integrates the Watt/hours 
of energy between markers or the portion of the 
waveform that is displayed. 
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Charge(C)/ 
Energy(J) 

For current traces, this integrates the 
Coulombs/second of charge between markers or 
the portion of the waveform that is displayed. 

For power traces, this integrates the energy in 
Joules between markers or the portion of the 
waveform that is displayed. 

CCDF/Histogram measurements 

Measurements Between Markers 

∆ Indicates the time span in seconds between the 
markers. 

% between 
markers 

Indicates the percent occurrence of the 
measurement values between the markers. 

Measurements from entire display 

10% Indicates the current value at the horizontal 10% 
decade. 

1% Indicates the current value at the horizontal 1% 
decade. 

.1% Indicates the current value at the horizontal 
0.1% decade 

Average Indicates the average current of all 
measurement values 

Exporting the Display Data 
The export data function lets you information from selected 
measurement traces to a .csv file.  

Step 1. Select the File menu from the top of the main window. Then select 
Export Data. 

The Export Data command applies to the Scope, Data Logger, and 
CCDF functions only. 

Step 2. Select the data traces that your wish to export. 

Step 3. Select a directory and filename in which to save the display data. File 
format extensions include: 

".csv" for comma-separated values  

The saved .csv file may be opened using a number of applications 
such as Microsoft Excel or a text editor. It can also be imported into 
the Arb Waveform function. The first row in the file is the title. The 
second row indicates the sample rate in seconds for collected data. 
The first column indicates the time of the data points. Each trace is 
assigned a subsequent column in the file, with a column label 
followed by all of the data points for each waveform. 





 

14585A Quick Start Guide 33 

4 
Reference Information 
Command Menu ................................................................................................ 34 
Error Log .............................................................................................................. 36 
Toolbars .............................................................................................................. 37 
Navigation controls ........................................................................................... 38 
Built in Waveforms ........................................................................................... 39 
Licensing ............................................................................................................. 42 
 

 

This chapter contains reference information about the menu 
commands, toolbars, and navigation controls. It describes the built-in 
waveform parameters and how to obtain and install the Agilent 
14585A software license. 
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Command Menu 

File menu 

Load Applies to the Scope, Data Logger, and CCDF functions only. 
Loads a display that was previously saved. 

Save  Applies to the Scope and CCDF functions only. Saves the 
present display to a file. 

Load Waveform Applies to the Arb function only. Loads an Arb waveform 
sequence that was previously created and saved. 

Save Waveform Applies to the Arb function only. Saves the Arb waveforms 
that were created. 

Save Workspace Apples to all functions. Saves all function settings, connection 
settings, and Arb selections to a file. 

Load Workspace Apples to all functions. Loads all function settings, connection 
settings, and Arb selections that were previously saved. 

Export Data Apples to the Scope, Data Logger, and CCDF functions only. 
Selects the traces to export. The data from the selected traces 
is written to a CSV file. 

Print Displays a preview of the waveform output. The preview can 
then be sent to the specified printer. 

Exit Exits the application. 

Edit menu 

Copy Chart Image Copies the display content to the clipboard. 

Copy Chart Image 
(white background) 

Copies the display content to the clipboard with a white 
background. 

Tools menu 

Configure IO Configures the interface that will communicate with the DC 
Power Analyzer. 

Instrument Control Controls the DC Power Analyzer. Displays the front panel 
view as seen on the actual instrument.  

User Preferences Configures the measurement preferences and IO search 
parameters. 
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Scope menu 

Clear Display Clears all scope measurement data. 

Deselect All Traces Removes all selected traces from the left side of the display. 

Measurement 
Ranges 

Specifies a measurement range for the output channel. 

Save Trace to Arb Saves a selected scope trace to the Arb Import tab. 

Properties Displays the scope properties that have been set. 

Data Logger menu 

Clear Display Clears all logged data. 

Deselect All Traces Removes all selected traces from the left side of the display. 

Measurement 
Ranges 

Specifies a measurement range for the output channel. 

Edit Event Tags Add/Edit/Delete event tag labels and categories to the datalog. 

Convert to CCDF Converts the opened datalog traces to CCDF. 

Properties Displays the data logger properties that have been set. 

CCDF menu 

Clear Display Clears all CCDF/Histogram data. 

Deselect All Traces Removes all traces that have been selected on the bottom of 
the display. 

Measurement 
Ranges 

Specifies a measurement range for the output channel. 

Properties Displays the CCDF properties that have been set. 

ARB menu 

Clone Trace Copies the selected trace to another channel or moves the 
trace to the alternate function of the same channel. 

Clear Display Clears all Arb sequences. 

Source Ranges Specifies an output range for the output channel. 

Run button Specifies the output state and Arb data source when the Arb 
runs.  

Statistics Displays all statistics about the Arb Waveform function. 
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Help menu 

Help Displays the built-in Help in a separate window. 

About Displays information about the selected DC Power Analyzer 
mainframe and the installed power modules. 

i Displays the same information as Help About. 

 

Error Log 

Click on the Error Log tab to list all the application errors that occur. 

 

Errors are categorized as follows: 

● Blue - indicates a low impact error, usually providing 
instructions on what to do to continue.  

● Yellow - indicates a medium impact error, such as the value 
entered is outside the acceptable parameter range.  

● Red - indicates a severe impact error, such a when connectivity 
to an instrument has been lost. 

Clicking on the colored Show ● ● ●  buttons includes or excludes the 
error category from the error log. 

Clear All clears all errors from the error log. 

Copy All copies all errors to the Windows clipboard. 

 



Reference Information    4 

14585A Quick Start Guide 37 

Toolbars 

Function Toolbar  

Scope - lets you capture and display output waveforms.  

Data Logger - lets you log output voltage and  current data for an 
extended time period. 

CCDF - lets you concisely summarize short and long-term battery 
drain measurements for analysis and comparison. 

ARB - lets you create complex waveforms based on combinations of 
basic waveforms using an interactive editor. 

Sequence Toolbar  
The Sequence toolbar is located in the center of the Arb Waveform window. 

Browse controls (<<, <, >, >>) 

Browse controls let you traverse the sequence to select (activate) a 
component for editing. Browse controls do not reposition the 
components in the sequence.  

Edit Controls (Move Left, Add, Modify, Delete, Move Right) 

Edit controls let you move and edit and the selected component. 
Move Left moves the selected component one position to the left. 
Move Right moves the selected component to the right. Add appends 
or adds a component to the end of the sequence. Modify lets you edit 
the selected component.  Delete deletes the selected component.  

Sequence Repeat specifies how many times the entire sequence will 
repeat. 

Markers Toolbar  
The Markers toolbar is located on the left of the marker area in the 
Scope and Data Logger windows. 

 Lets you select the measurement items. 

Resets the markers to the edges of the display. 

Removes the markers. Calculations will be based on the 
visible data in the display. 
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Navigation controls 

Mouse 
Click and hold down the mouse on any area of the display. The 
display moves horizontally or vertically as you move the mouse. 

Wheel 
Moving the mouse wheel changes the horizontal time/divison of the 
display. If one of the traces has been selected by clicking on it, 
moving the wheel changes the vertical gain of the trace.  

Zoom Controls  
The Zoom controls are located in the lower right of the Scope and 
Data Logger windows. 

AutoScale scales the display so that all traces fit into the display 
area. 

 zooms in on the selected area of the display. Use the mouse to 
draw a rectangle of the zoom area. 

+  zooms in on the center of the display. 

−  zooms back out of the zoom area. 

Data Bar  
The Data bar is located in the lower center of the Scope and Data Logger 
windows. 

 

The yellow part indicates the portion of the data that is visible on the 
display.  

The gray part represents the data that is not visible. Note that when 
you get to the end of the data, you can move all of the data off the 
display. 

Browse controls (<<, <, >, >>) let you traverse the data. 
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Built-in Waveforms 

NOTE There is a 10 kHz frequency limit for all arbitrary waveforms. This is the highest 
frequency available that still provides good output fidelity for each Arb. 

 

Exponential Start Amplitude - the amplitude before the waveform starts 

End Amplitude - the final amplitude of the waveform 

Delay - the delay after the trigger is received but before the 
waveform starts 

Rise Time - the transition time from the start amplitude to the end 
amplitude 

Time Constant - the time constant of the exponential curve 

Repeat Count - the number of times the waveform repeats 

Gaussian Peak Amplitude - the peak amplitude of the waveform 

Offset - the offset from zero 

Peak Positive Time - the time from the start to the peak amplitude 

Half Width Time - the width of the waveform at half of the peak 
amplitude 

Noise Amplitude - the amplitude or peak value 

Offset - the offset from zero 

Frequency - the frequency of the waveform 

Start Time - the start time of the waveform 

Duration - the duration of the waveform 

Pulse Start Amplitude - the amplitude before and after the pulse 

End Amplitude - the amplitude of the pulse 

Delay - the delay after the trigger is received but before the pulse 
starts 

Pulse Time - the time (width) of the pulse 

End Time - the time the output stays at the start amplitude after the 
pulse 

Repeat Count - the number of times the pulse repeats 
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Ramp Start Amplitude - the amplitude before the ramp 

End Amplitude - the amplitude after the ramp 

Delay - the delay after the trigger is received but before the ramp 
starts 

Ramp Time - the time that the output ramps up 

End Time - the time the output remains at the end amplitude 

Repeat Count - the number of times the waveform repeats 

Ringing Delay - the delay after the trigger is received but before the 
waveform starts 

Amplitude - the amplitude or peak value 

Offset - the offset from zero 

Frequency - the frequency of the waveform 

Decade - the duration of the ringing in decades 

Sinc Peak Amplitude - the peak amplitude of the normalized waveform 

Offset - the offset from zero 

Peak Position Time - the time until the peak position of the 
waveform 

Zero Crossing Frequency - the zero crossing frequency of the 
waveform 

Sine Amplitude - the amplitude or peak value 

Offset - the offset from zero 

Frequency - the frequency of the sine wave 

Phase - the start phase angle of the sine wave 

Repeat Count - the number of times the sine wave repeats 
Square Amplitude - the amplitude or peak value 

Offset - the offset from zero 

Frequency - the frequency of the square wave 

Duty - the duty cycle of the square wave 

Phase - the start phase angle of the square wave 

Repeat Count - the number of times the waveform repeats 

Stair Step Start Amplitude - the amplitude before the staircase starts 

One Step Amplitude - the amplitude of each step 

Number of Steps - the total number of staircase steps 

Delay - the delay after the trigger is received but before the 
waveform starts 

Stair Step Time - the time to complete all of the steps 

End Time - the time the waveform stays at the final amplitude 

Repeat Count - the number of times the waveform repeats 
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Step Start Amplitude - the amplitude before the step 

End Amplitude - the amplitude of the step 

Delay - the delay after the trigger is received but before the step 
occurs 

End Time - the time the output stays at the end amplitude 

Swept Amplitude - the amplitude or peak value 

Offset - the offset from zero 

Start Frequency - the start frequency of the waveform 

End Frequency - the end frequency of the waveform 

Duration - the duration or length of the waveform 

Trapezoid Start Amplitude - the amplitude before and after the trapezoid 

Delay - the delay after the trigger is received but before the 
trapezoid starts 

Peak Amplitude - the peak amplitude of the trapezoid 

Start Time - the time before the trapezoid ramps up 

Rise Time - the time that the trapezoid ramps up 

Peak Time - the time at the peak amplitude 

Fall Time - the time that the trapezoid ramps down 

End Time - the time the output stays at the start amplitude after the 
trapezoid 

Repeat Count - the number of times the waveform repeats 

Triangle Amplitude - the amplitude or peak value 

Offset - the offset from zero 

Frequency - the frequency of the waveform 

Phase - the start phase angle of the waveform 

Repeat Count - the number of times the waveform repeats 
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Licensing 
The Agilent 14585A software requires that each connected Agilent 
N6705 DC Power Analyzer has a License key installed in it. The 
license key for the Agilent N6705 can be ordered with the instrument 
when you purchase the N6705 with Option 056. It can also be 
purchased separately as N6705U Option 056. 

One license key is required for each N6705 DC Power Analyzer. The 
license key is based on the DC Power Analyzer mainframe's serial 
number and is installed into the specific instrument for which it was 
ordered. Once a license key has been redeemed, it cannot be 
transferred to a different instrument. 

Obtaining the License Key 
Step 1. To obtain an Agilent 14585A license key for an Agilent N6705 DC 

Power Analyzer you will need: 

a. The Agilent 14585A Control and Analysis Software. (This software 
is free to download and use for a specific time.) 

b. The serial number of the Agilent N6705 DC Power Analyzer 
mainframe for which you will be obtaining the license key. The serial 
number is a 10-character string in the format MY12345678. You can 
obtain the serial number as follows: 

 Look at the serial number tag on the rear panel of the unit. 

 On the front panel, press Settings, then Properties. 

 Query the power analyzer with the *IDN? Command. 

c. Your email address. 

d. Your Order number and Certificate number. These appear in the 
upper right cornet of the Software Entitlement Certificate that was 
provided when you ordered the Agilent N6705B-056 or N6705U-056. 

Step 2. To get the license key. log onto the website 
https://software.business.agilent.com/asm and follow the on-screen 
directions. These include: 

a. Creating a user account, if one is not already set up. 

b. Entering your Order and Certificate number 
   (these appear in your Software Entitlement Certificate).  

c. Entering the Host instrument's 10-character serial number 
   (this is located on the rear panel of the instrument). 

d. Selecting the software license for the instrument. 

When you have completed the license request, a license key will be 
sent to your email. When received, refer to "Installing the License 
Key". 

http://www.agilent.com/find/softwarelicense
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Installing the License Key 
A license key was emailed to you after you completed the procedure 
under "Obtaining the License Key". 

To Install the license key using the Agilent 14585A software: 

Step 1. Run the Agilent 14585A software and select Configure IO in the Edit 
menu. 

Step 2. From the list, select the Agilent N6705 that you wish to license. Click 
on the License button to display the Licensing dialog. 

Step 3. Enter the license key from the email into the License Key field and 
click Enter. 

Step 4. The license is now installed. Use a black permanent marker and 
check the "[ ]  Add License for 14585A Control and Analysis 
Software" box on the Options label on the back of your Agilent N6705 
instrument. 

To Install the license key using the Agilent N6705 DC Power 
Analyzer: 

Step 1. Turn on the DC Power Analyzer and select Utilities in the front panel 
Menu. 

Step 2. Scroll to Administrative Tools and  log in (refer to the Agilent 
N6705A User's Guide for details). 

Step 3. When logged in, select Install Options. 

Step 4. In the Option drop-down box, select "056 - Enable 14585A Software" 

Step 5. Use the keypad to enter the license key from the email into the Key 
field and click Enter. 

Step 6. The license is now installed. Use a black permanent marker and 
check the "[ ]  Add License for 14585A Control and Analysis 
Software" box on the Options label on the back of your Agilent N6705 
instrument. 
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